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Denne e-bog er udleveret gratis via Lene Fredborgs Word Blog. 

Hvis du kender andre, som er interesserede i e-bogen, så henvis til https://www.thedoctools.com/wordtips, hvorfra e-bogen kan hentes gratis. 

Kopiering fra denne e-bog eller dele deraf er kun tilladt i overensstemmelse med overenskomst mellem Undervisningsministeriet og Copydan. 

Microsoft® Word er et registreret varemærke tilhørende Microsoft Corporation i USA og/eller andre lande. 

Forfatteren kan ikke holdes ansvarlig for direkte eller indirekte tab eller skade, der måtte opstå som følge af brug af denne e-bog. 

Om forfatteren 

Lene Fredborg står bag firmaet DocTools ApS, www.thedoctools.com. DocTools designer og udvikler professionelle skabeloner (templates) og effek-

tive værktøjer i form af add-ins og makroer til Microsoft Word. Det overordnede formål er at hjælpe virksomheder til at øge produktiviteten og forbed-

re kvaliteten i virksomhedens dokumenter. Lene Fredborg har mere end 25 års erfaring med Microsoft Word og programmering i Microsoft Visual 

Basic (VBA) via sit arbejde med bl.a. dokumentautomatisering, dokumentskabeloner, dokumenthåndtering og brugerdokumentation – tidligere i stør-

re IT-virksomheder og nu i DocTools. 

Lene Fredborg har hvert år siden 2008 modtaget den prestigefyldte pris som Microsoft MVP (Most Valuable Professional) i Word som anerkendelse 

for sin hjælp til Microsoft Word-brugere over hele verden. 

https://www.thedoctools.com/wordtips
https://www.thedoctools.com/wordtips
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Lidt om de 10 gode råd 

Microsoft Word er et meget avanceret tekstbehandlingsprogram, som rummer utroligt omfattende funktionalitet. De fleste Word-brugere an-

vender kun en lille del af de mange muligheder. 

I denne e-bog har jeg udvalgt 10 gode råd ud af de mange, der kunne være god grund til at tage med. Hvert af de 10 råd omhandler et emne, 

som jeg finder vigtigt i forhold til at få det bedste ud af Word, så du kan lave bedre dokumenter på kortere tid. 

Tanken med e-bogen er at give dig inspiration til at udnytte flere muligheder i Word, end du måske plejer at gøre. For hvert råd har jeg forklaret 

lidt om, hvorfor jeg finder det vigtigt, og hvad jeg mener, du kan få ud af at udnytte det pågældende råd. Du vil også finde links til yderligere in-

formation under de enkelte råd. De fleste af disse links går til information på min blog, https://www.thedoctools.com/wordtips. Bloggen bliver 

udbygget med nye artikler om Word i den takt, jeg kan få tid til at skrive nyt. Det sker også tit, at jeg opdaterer eksisterende artikler. Emnerne 

slipper vist aldrig op. 

Øvelse gør mester! 

Hvis man skal ændre vaner eller lære noget nyt, og hvis man skal blive rigtig god til noget, er man nødt til at investere tid og kræfter i det. Hvis 

du arbejder jævnligt med Word, og hvis du ikke allerede udnytter de muligheder, jeg har beskrevet i denne e-bog, kan det være end god ide at 

bruge lidt tid på at dykke ned i mulighederne. 

Jeg håber, at et eller flere af de 10 råd kan hjælpe dig til at lave bedre dokumenter på kortere tid, eller at de kan inspirere dig til at undersøge 

andre muligheder for at lette og effektivisere dit arbejde i Word. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips
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1. Brug skabeloner (templates) til at styre det overordnede udseende af dokumenter 

1.1 Hvorfor? 

Bag alle dokumenter, du opretter i Word, findes der en skabelon (engelsk: template). Når du opretter et nyt dokument, er det altid baseret på 

en skabelon. Hvis du ikke gør noget bevidst for at vælge en skabelon, er det den skabelon, der hedder Normal.dotm, der anvendes. I Word 

2003 og tidligere versioner af Word er skabelonen i dot-format i stedet for dotm-format. 

Sørg for at have en skabelon pr. dokumenttype, som du jævnligt arbejder med. Så er grundlaget i det enkelte dokument på plads fra starten. 

Hvis en dokumenttype f.eks. altid skal indeholde bestemte afsnit, så sørg for, at disse afsnit er indeholdt i skabelonen. Man kan f.eks. bruge 

felter til at styre variable data som kundenavne, produktnavne m.m. (se afsnit 10, ”Lær at forstå felter og få mange fantastiske muligheder”). 

Måske finder din brug af Word sted i forbindelse med arbejde i en virksomhed. Hvis du og eventuelle kolleger ikke har gode Word-skabeloner 

til rådighed til de opgaver, der skal løses, kan du måske foreslå, at der bliver gjort noget ved det problem. Et er, at Word-brugerne spilder tid og 

måske bliver frustrerede og irriterede over dokumenter, som driller. Den spildte tid kan også koste en virksomhed rigtig mange penge. 

1.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/skabelon-word-basis/ Artiklen Skabeloner i Word – grundlaget for alle dokumenter giver en introduktion til 

skabeloner. 

https://www.thedoctools.com/wordtips/hvad-arver-et-word-

dokument-fra-den-tilknyttede-skabelon/ 

Artiklen Hvad arver et Word-dokument fra den tilknyttede skabelon? giver dig indblik i 

sammenhængen mellem skabelon og dokument. 

https://www.thedoctools.com/wordtips/category/skabelon/ Her kan du bladre igennem artikler på min blog, som er relateret til Skabeloner. Alle 

emner er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Skabeloner. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/skabelon-word-basis/
https://www.thedoctools.com/wordtips/skabelon-word-basis/
https://www.thedoctools.com/wordtips/hvad-arver-et-word-dokument-fra-den-tilknyttede-skabelon/
https://www.thedoctools.com/wordtips/hvad-arver-et-word-dokument-fra-den-tilknyttede-skabelon/
https://www.thedoctools.com/wordtips/hvad-arver-et-word-dokument-fra-den-tilknyttede-skabelon/
https://www.thedoctools.com/wordtips/category/skabelon/
https://www.thedoctools.com/wordtips/sitemap/
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2. Lær at anvende typografier (styles) og få meget bedre styr på formateringen 

2.1 Hvorfor? 

Typografier er en af grundstenene i Word. En typografi (engelsk: style) i Word er en samling af instruktioner, der fastlægger formateringen af 

tekst, dvs. skrifttype, skriftstørrelse, farve og et stort antal andre egenskaber. Ethvert Word-dokument indeholder som udgangspunkt en stor 

samling af typografier, som er defineret til forskellige formål. Der er typografier til overskrifter, brødtekst (dvs. den almindelige tekst) og meget 

andet. Du kan ændre de enkelte typografier, så de passer til dine behov. Du kan også oprette alle de nye typografier, du ønsker. 

Word anvender altid en typografi til et afsnit, uanset om du vælger den bevidst eller ej. Mange er vant til blot at skrive løs og løbende formatere 

teksten ved at markere teksten og f.eks. gøre teksten fed eller ændre skriftstørrelsen – det kaldes også direkte formatering. Hvis du arbejder 

på den måde, vil typografien Normal typisk være anvendt til det meste af teksten. 

Der er mange ulemper ved at arbejde på den måde. Dels tager det meget længere tid at formatere teksten manuelt, dels er det meget svært at 

sikre konsistens i formateringen, ikke blot i det enkelte dokument, men også på tværs af dokumenter. Endelig er det meget besværligt at æn-

dre dokumentets layout, hvis det bliver nødvendigt, og man går glip af mulighederne for at bruge mange af de rigtig smarte funktioner i Word. 

2.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/om-typografier-del1/ 

https://www.thedoctools.com/wordtips/om-typografier-del2/ 

Artiklerne Lær at anvende typografier i Word – DEL I og Lær at anvende typografier i 

Word – DEL II giver en introduktion til typografier. Her finder du også en liste af fordele 

ved at anvende typografier. 

https://www.thedoctools.com/wordtips/category/typografi/ Her kan du bladre igennem artikler på min blog, som er relateret til Typografier. Alle 

emner er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Typografier. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/om-typografier-del1/
https://www.thedoctools.com/wordtips/om-typografier-del2/
https://www.thedoctools.com/wordtips/om-typografier-del1/
https://www.thedoctools.com/wordtips/om-typografier-del2/
https://www.thedoctools.com/wordtips/om-typografier-del2/
https://www.thedoctools.com/wordtips/category/typografi/
https://www.thedoctools.com/wordtips/sitemap/
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3. Brug altid typografierne Overskrift 1-9 til overskrifter og få mange fordele forærende 

3.1 Hvorfor? 

Som forklaret i foregående afsnit, er det er rigtig god ide at lære at anvende typografier systematisk, hvis du ikke allerede gør det. Nogle af de 

indbyggede typografier i Word er født med særlige egenskaber, som du ikke kan genskabe i typografier, du selv opretter fra bunden. Det gæl-

der f.eks. typografierne Overskrift 1-9 (engelsk: Heading 1-9). Hvis du bruger disse typografier til alle dine overskrifter, får du mange fordele 

forærende. Når du har anvendt Overskrift 1-9 i et dokument, kan du f.eks. let lave en indholdsfortegnelse eller indsætte krydshenvisninger 

til overskrifter, og alle disse data kan opdateres blot ved at markere indholdet og taste F9, som opdaterer felter. Du kan også definere overskrif-

terne, så de har automatisk nummerering (1, 1.1, 1.1.1, 1.2, 1.2,1 osv.). Hvis nummereringen er sat op, så numrene er kædet korrekt sam-

men, vil de automatisk skifte korrekt, når du ændrer indholdet. Hvis du f.eks. indsætter et nyt afsnit med typografien Overskrift 1 forrest i do-

kumentet, vil alle efterfølgende afsnit inkl. underafsnit automatisk skifte til 2, 2.1, 2.2, 2.3, 2.1.1, 2.1.2 osv. 

Du kan tilrette udseendet af typografierne Overskrift 1, Overskrift 2, … , Overskrift 9, så de ser ud præcis, som du ønsker. 

Du kan definere overskrifterne med eller uden nummerering (1, 1.1, 1.1.1 osv.). Alle typografier til overskrifter bør også via dialogboksen Afsnit 

(Paragraph) defineres, så de automatisk holder sammen med næste afsnit, og så linjerne i selve overskriften holdes sammen. Det vil 

forhindre en overskrift i at havne nederst på en side – overskrifter inde i en tekst bør altid følge med det næste afsnit. 

I almindelighed er der ikke brug for alle ni niveauer af overskrifter. Det er normalt en god ide at holde sig til maksimalt fire niveauer. 

3.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/category/typografi/ Her kan du bladre igennem artikler på min blog, som er relateret til Typografier. Alle 

emner er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Typografier. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/category/typografi/
https://www.thedoctools.com/wordtips/sitemap/
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4. Brug tastaturgenveje og højrekliks-menuer og spar masser af tid 

4.1 Hvorfor? 

Arbejdet i Word – og i mange andre programmer – bliver så utrolig meget hurtigere, hvis man erstatter i det mindste nogle af de mange muse-

klik med brug af tastaturet. På den måde nedsætter du i øvrigt også risikoen for at få museskader. Der er knyttet tastaturgenveje til mange 

kommandoer, men du kan også selv oprette tastaturgenveje til kommandoer, som du bruger tit. 

Somme tider hører jeg nogen sige, at det er besværligt at huske tastaturgenvejene. Hvis du har det sådan, kan du sætte sig for, at du vil lære 

en ny tastaturgenvej om dagen eller om ugen. Der findes en del tastaturgenveje, som virker i de allerfleste programmer. Hvis du ikke er vant til 

at bruge tastaturgenveje, vil jeg foreslå, at du starter med at lære nogle af de genveje. Første link nedenfor indeholder en liste klar til brug. 

Du kan også spare tid ved at vælge kommandoer fra den menu, der vises, når du højreklikker i et dokument. Indholdet i højrekliks-menuer 

afhænger af konteksten. Valgmulighederne er f.eks. forskellige, når du højreklikker i en tabel og i almindelig tekst. Højrekliks-menuer inde-

holder normalt nogle af de kommandoer, der bruges tit. Bemærk, at højrekliks-menuer skifter indhold, hvis markøren er placeret i tekst med 

røde bølgestreger, der markerer af en mulig stavefejl – så vinder kommandoer til håndtering af stavning over de normale kommandoer. 

4.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/brug-tastaturgenveje-spar-tid/ I artiklen Brug tastaturgenveje – spar tid finder du en liste af nyttige tastaturgenveje. 

Du kan også downloade listen i PDF-format, lige til at udskrive, så du kan have den 

liggende ved computeren, indtil genvejene sidder på rygraden. 

https://www.thedoctools.com/wordtips/f4_tastaturgenvej-som-

sparer-masser-af-tid-i-word/ 

F4 er en af de tastaturgenveje, som kan spare dig for oceaner af tid. Se F4 – en fanta-

stisk nyttig tastaturgenvej, som kan spare dig for masser af tid i Word. 

https://www.thedoctools.com/wordtips/category/tastaturgenvej/ Her kan du bladre igennem artikler på min blog, som er relateret til Tastaturgenveje. 

Alle emner er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Tastaturgenveje. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/brug-tastaturgenveje-spar-tid/
https://www.thedoctools.com/wordtips/brug-tastaturgenveje-spar-tid/
https://www.thedoctools.com/wordtips/f4_tastaturgenvej-som-sparer-masser-af-tid-i-word/
https://www.thedoctools.com/wordtips/f4_tastaturgenvej-som-sparer-masser-af-tid-i-word/
https://www.thedoctools.com/wordtips/f4_tastaturgenvej-som-sparer-masser-af-tid-i-word/
https://www.thedoctools.com/wordtips/f4_tastaturgenvej-som-sparer-masser-af-tid-i-word/
https://www.thedoctools.com/wordtips/category/tastaturgenvej/
https://www.thedoctools.com/wordtips/sitemap/


 
 
10 gode råd – Lav bedre dokumenter på kortere tid i Microsoft Word 

Copyright © 2013-2021– Lene Fredborg, DocTools ApS, www.thedoctools.com – Tilmeld dig nyhedsbrev 9 

 

5. Vis formateringsmærker for at få totalt styr på indhold og formatering 

5.1 Hvorfor? 

Formateringsmærker er tegn, som kun vises på skærmen. De udskrives ikke. Du kan slå vis-

ning af formateringsmærker til og fra ved at taste Ctrl+Shift+8 eller ved at klikke på ikonet ¶ på 

fanen Startside / Hjem (engelsk: Home). 

Det kræver for de fleste nogen tilvænning at se på teksten med formateringsmærkerne slået til. 

Men jeg vil meget stærkt anbefale at prøve. Det er absolut umagen værd, og på sigt vil det 

spare dig for både masser af tid og være med til at hindre problemer. Måske vælger du at slå 

formateringsmærker til somme tider, og det er langt bedre end aldrig. 
 

Eksempler på formateringsmærker 

Kun ved at arbejde med formateringsmærker slået til kan du få fuldt styr på indholdet i dit dokument, og formateringsmærkerne vil meget tit af-

sløre årsagen til et problem, f.eks. hvis der er en tom side, som du ikke kan fjerne eller noget med sidehoved og -fod, du ikke kan få styr på. 

5.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/tips-om-formateringsmaerker-i-

word/ 

I artiklen Tips om formateringsmærker – de sære prikker, ¶-tegn og pile, du måske 

somme tider ser i Word har jeg forklaret mere om, hvorfor det er en rigtig god ide at 

vænne sig til at arbejde med formateringsmærker slået til. 

https://www.thedoctools.com/demos/demo_tips_formatting_marks.html Via linket til venstre kan du starte en lille video på ca. 4 minutter, som jeg har lavet 

for at vise, hvordan formateringsmærker virker. Videoen er med engelsk tekst. 

https://www.thedoctools.com/us/formatting_marks_overview_dk.pdf  Linket åbner en PDF-fil med oversigt over formateringsmærker med danske forkla-

ringer på de enkelte tegn. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/tips-om-formateringsmaerker-i-word/
https://www.thedoctools.com/wordtips/tips-om-formateringsmaerker-i-word/
https://www.thedoctools.com/wordtips/tips-om-formateringsmaerker-i-word/
https://www.thedoctools.com/wordtips/tips-om-formateringsmaerker-i-word/
https://www.thedoctools.com/demos/demo_tips_formatting_marks.html
https://www.thedoctools.com/us/formatting_marks_overview_dk.pdf
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6. Tilpas indstillinger, så det er dig og ikke Microsoft Word, der har styringen 

6.1 Hvorfor? 

Der findes et stort antal indstillinger i Word, som du kan ændre på. Nogle af disse indstillinger er som standard sat sådan, at Word ud fra det, 

du foretager dig, vil gætte på, hvad du gerne vil opnå. Og vupti – små bogstaver forvandles til store, tre bindestreger bliver til understregning af 

en hel linje osv. I nogle tilfælde er det lige, hvad du ønsker, men det er det givetvis ikke altid. Nogle af funktionerne vil ændre typografier. Hvis 

du og ikke Word skal have styringen, gør du klogt i at ændre på en del indstillinger. Nogle af de indstillinger, man kan have specielt øje til, er 

dem, der hedder noget med ”Smart …” – de er helt sikkert af den type, som ”kloger sig” på dine vegne. Generel sti til indstillingerne i Word: 

Word 2010 og nyere versioner af Word Filer > Options (File > Options) 
Word 2007 Office-knappen > Word-indstillinger (Office button > Word Options) 
Word 2003 Funktioner > Indstillinger (Tools > Options) 

6.2 Eksempler på konkrete indstillinger, som jeg vil anbefale dig at ændre 

Indstilling Hvor findes indstillingen (… betyder følg først den generelle sti vist ovenfor) 

Slå feltskygge til, så alle felter vises med grå baggrund på skærmen. 

Feltskygge vises ikke i udskrift, men det er en stor hjælp at kunne 

skelne felter fra almindelig tekst på skærmen. Hvis du ændrer manuelt 

i et felt, mistes ændringen, når feltet opdateres. 

Word 2007 og 
nyere version 

… > Avanceret > Vis dokumentindhold > Feltskygge > Altid 
(… > Advanced > Show document content > Field shading > Always) 

Word 2003 … > fanen Vis > Feltskygge > Altid 
(… > View tab > Field shading > Always) 

Slå følgende indstillinger fra på fanen Autoformat under skrivning i 

dialogboksen Autokorrektur (AutoCorrect > Autoformat As You Type) 

 

Word 2007 og 
nyere version 

… > Korrektur > Indstillinger for Autokorrektur 
(… > Proofing > AutoCorrect Options) 

Word 2003 Funktioner > Indstillinger for Autokorrektur 
(Tools > AutoCorrect Options) 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
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7. Lær at udnytte Søg og erstat og spar oceaner af tid 

7.1 Hvorfor? 

Word indeholder en meget effektiv funktion til at søge og erstatte indhold i dokumenter. I stedet for manuelt at rette det samme mange steder, 

kan du bruge Søg og erstat (engelsk: Find and Replace) til at klare opgaven – det vil spare masser af tid og samtidig formindske risikoen for 

fejl. Tast Ctrl+H for at åbne dialogboksen Søg og erstat. Klik på Flere (More) nederst i dialogboksen for at få adgang til alle muligheder. 

7.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/soeg-erstat-tekst-med-

kopieret-indhold/ 

Artiklen Sådan kan du bruge Søg og Erstat til at udskifte tekst med noget, du lige har 

kopieret giver et eksempel på, hvad du kan gøre med Søg og erstat. 

https://www.thedoctools.com/wordtips/elementsoegning-hurtig-

metode-til-at-finde-indhold-af-bestemt-type-i-word/ 

Via artiklen Elementsøgning – en hurtig metode til at finde indhold af en bestemt type i 

et Word-dokument kan du se en video, hvori jeg viser en speciel søgefunktion i Word, 

som du sandsynligvis kan have glæde af. Desværre har Microsoft fjernet funktionen i 

Word 2013 og Word 2016 (alternativ metoder er beskrevet i artiklen). 

https://wordmvp.com/FAQs/General/UsingWildcards.htm Artiklen Finding and replacing characters using wildcards (er på engelsk) giver dig 

indblik i, hvordan du kan bruge jokertegn (wildcards) i forbindelse med søg og erstat. 

Det kan være lidt ”langhåret” at komme i gang med, men du kan opnå de mest utrolige 

ting, hvis du sætter dig ind i principperne. 

https://www.thedoctools.com/wordtips/category/sog-og-erstat/ Her kan du bladre igennem artikler på min blog, som er relateret til Søg og erstat. Alle 

emner er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Søg og erstat. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/soeg-erstat-tekst-med-kopieret-indhold/
https://www.thedoctools.com/wordtips/soeg-erstat-tekst-med-kopieret-indhold/
https://www.thedoctools.com/wordtips/soeg-erstat-tekst-med-kopieret-indhold/
https://www.thedoctools.com/wordtips/soeg-erstat-tekst-med-kopieret-indhold/
https://www.thedoctools.com/wordtips/elementsoegning-hurtig-metode-til-at-finde-indhold-af-bestemt-type-i-word/
https://www.thedoctools.com/wordtips/elementsoegning-hurtig-metode-til-at-finde-indhold-af-bestemt-type-i-word/
https://www.thedoctools.com/wordtips/elementsoegning-hurtig-metode-til-at-finde-indhold-af-bestemt-type-i-word/
https://www.thedoctools.com/wordtips/elementsoegning-hurtig-metode-til-at-finde-indhold-af-bestemt-type-i-word/
https://wordmvp.com/FAQs/General/UsingWildcards.htm
https://wordmvp.com/FAQs/General/UsingWildcards.htm
https://www.thedoctools.com/wordtips/category/sog-og-erstat/
https://www.thedoctools.com/wordtips/sitemap/
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8. Udnyt Autokorrektur til automatisk indsættelse af tekst og til rettelse af slåfejl 

8.1 Hvorfor? 

Autokorrektur (engelsk: AutoCorrect) kan hjælpe dig ved automatisk at udskifte tekst, mens du 

skriver. Hvis du f.eks. igen og igen skal skrive et langt produktnavn eller en bestemt formulering, 

kan du føje et element til Autokorrektur, så du kun skal skrive nogle få tegn i stedet. Sørg endelig 

for at angive et kort navn, som ikke er et almindeligt ord. Hvis du f.eks. navngiver et element ”pro-

dukt”, kan du ikke længere skrive ordet produkt, uden at Word udskifter det, og det er jo ikke så 

smart. Jeg bruger tit en underscore som det første tegn. Brug også Autokorrektur til at rette slåfejl. 

Word indeholder som standard en lang Autokorrektur-liste. Hvis Word udskifter tekst, som ikke 

skal udskiftes, så tjek listen under Autokorrektur. Måske er der et element, du skal have slettet. 

Bemærk, at autokorrektur er sprogafhængig. Listen skifter, hvis du skifter sprogindstilling i teksten. 

Du kan bruge Autokorrektur til at erstatte det skrevne med andet end tekst, f.eks. et felt, et symbol 

eller et billede – eller flere afsnit. Gør sådan: Indsæt det ønskede indhold i dit dokument og mar-

kere indholdet. Åbn nu dialogboksen Autokorrektur > fanen Autokorrektur. Skriv navn i feltet 

Erstat. Slå Formateret tekst til over venstre felt, men lad selve feltet være tomt. Klik Tilføj og 

OK. Hver gang du skriver det korte navn og taster mellemrum, punktum eller en anden adskiller, 

vil Word indsætte det indhold, du havde markeret, da du oprettede dit Autokorrektur-element. 

 

8.2 Hvor kan du finde mere information? 

Links Bemærkninger 

http://office.microsoft.com/da-dk/outlook-help/automatisk-rette-

stavefejl-og-indsaette-tekst-og-symboler-HA010354277.aspx 

I artiklen Automatisk rette stavefejl og indsætte tekst og symboler finder du en basal 

vejledning i brugen af Autokorrektur-funktionen. 

http://technet.microsoft.com/en-us/magazine/ff956104.aspx Autokorrektur-listen gemmes i en separat fil, som kan kopieres til andre brugere, hvis 

flere har behov for samme liste. Se artiklen Share Custom AutoCorrect Entries with 

Other Computers and Users (artiklen findes ikke på dansk). 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
http://office.microsoft.com/da-dk/outlook-help/automatisk-rette-stavefejl-og-indsaette-tekst-og-symboler-HA010354277.aspx
http://office.microsoft.com/da-dk/outlook-help/automatisk-rette-stavefejl-og-indsaette-tekst-og-symboler-HA010354277.aspx
http://office.microsoft.com/da-dk/outlook-help/automatisk-rette-stavefejl-og-indsaette-tekst-og-symboler-HA010354277.aspx
http://technet.microsoft.com/en-us/magazine/ff956104.aspx
http://technet.microsoft.com/en-us/magazine/ff956104.aspx
http://technet.microsoft.com/en-us/magazine/ff956104.aspx


 
 
10 gode råd – Lav bedre dokumenter på kortere tid i Microsoft Word 

Copyright © 2013-2021– Lene Fredborg, DocTools ApS, www.thedoctools.com – Tilmeld dig nyhedsbrev 13 

 

9. Udnyt dokumentkomponenter / autotekst til let genbrug af indhold 

9.1 Hvorfor? 

I Word 2003 og tidligere versioner kan man oprette autotekster med dokumentindhold til genbrug. I Word 2007 og senere versioner kan man 

oprette og indsætte både autotekster og forskellige andre typer dokumentkomponenter. Hvis du i et dokument har indhold, som du eller an-

dre får brug for i andre sammenhænge, kan du markere indholdet og gemme det som en dokumentkomponent. Du kan f.eks. også gemme en 

eller flere tomme tabeller, der er sat op, som du vil have det. Så kan samme indhold lynhurtigt sættes ind i et hvilket som helst dokument. I 

Word 2007 og senere versioner bliver elementerne som udgangspunkt gemt i en skabelon, som hedder Building Blocks.dotx, men du kan 

vælge at gemme i en anden skabelon. I virksomheder kan man f.eks. oprette en eller flere skabeloner med dokumentkomponenter, som alle 

relevante brugere får installeret. På den måde kan man give let adgang til standardindhold og dermed både spare tid og sikre konsistens. 

Word 2007 og nyere versioner af Word indeholder fra starten mange dokumentkomponenter af forskellige typer, f.eks. forsider og tekstbokse. 

Kommandoer til at oprette og indsætte autotekster/dokumentkomponenter finder du sådan: 

Word 2016 og nyere versioner af Word Fanen Indsæt > Genvejselementer (Insert > Quick Parts) 
Word 2010 og Word 2007 Fanen Indsæt > Hurtige dele (Insert > Quick Parts) 
Word 2003 Menuen Indsæt > Autotekst (Insert > AutoText) 

9.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/flytning-af-autotekster-fra-

word-2003-til-word-2007-eller-word-2010/ 

Artiklen Flytning af Autotekster fra Word 2003 til nyere version af Word (gælder også 

Word 2013 og Word 2016) forklarer, hvordan du overfører autotekster fra Word 2003 til 

en nyere version af Word og hvordan du indsætter autotekster i Word. 

https://www.thedoctools.com/wordtips/category/autotekst/ Her kan du bladre igennem artikler på min blog, som er relateret til Autotekst og hur-

tige dele. Alle emner er vist under Find Word Tips om specifikke emner i panelet til 

højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Autotekst og hurtige dele. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/flytning-af-autotekster-fra-word-2003-til-word-2007-eller-word-2010/
https://www.thedoctools.com/wordtips/flytning-af-autotekster-fra-word-2003-til-word-2007-eller-word-2010/
https://www.thedoctools.com/wordtips/flytning-af-autotekster-fra-word-2003-til-nyere-version-af-word/
https://www.thedoctools.com/wordtips/category/autotekst/
https://www.thedoctools.com/wordtips/sitemap/
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10. Lær at forstå felter og få mange fantastiske muligheder for at styre indhold 

10.1 Hvorfor? 

Et felt indeholder instruktioner til Word om, hvad programmet skal gøre. Word giver mulighed for at indsætte alskens typer felter, som kan bru-

ges til mange fantastiske ting. Almindeligt brugte felter er PAGE, som bruges til sidetal, DATE, CREATEDATE m.fl., som bruges til dato/tid, 

TOC til indholdsfortegnelser, MERGEFIELD til brevfletning, REF og PAGEREF til krydshenvisninger. Selv bruger jeg DOCPROPERTY-felter 

rigtig meget til at styre data som f.eks. kundenavne, adresser og andre variable data i dokumenter. DOCPROPERTY-felter giver mulighed for 

at definere en værdi et sted, og så kan samme værdi gentages så tit, det er nødvendigt, ved hjælp af DOCPROPERTY-felter. 

Sådan åbner du dialogboks til oprettelse af felter i forskellige Word-versioner: 

Word 2013 og nyere versioner af Word Fanen Indsæt > Genvejselementer > Felt (Insert > Quick Parts > Field) 
Word 2010 og Word 2007 Fanen Indsæt > Hurtige dele > Felt (Insert > Quick Parts > Field) 
Word 2003 og tidligere version Menuen Indsæt > Felt (Insert > Field) 

I stedet for at indsætte felter via dialogboksen Felt, er det en god ide at lære at opbygge felterne manuelt. Det er næsten altid hurtigere, og 

det giver en god forståelse af felter, så du bedre kan udnytte deres muligheder eller finde og rette problemer. Alle felter er omgivet af et sæt 

klammer, som kan indsættes ved at taste Ctrl+F9 (du kan ikke blot skrive almindelige klammer). Eksempel på koden i et datofelt:  

{ CREATEDATE \@ “d. MMMM yyyy” }. Søg i f.eks. Google efter feltkoder [TYPE] (f.eks. feltkoder REF) for at finde hjælp til en type felt. Hvis 

du vil finde information på engelsk, så skriv field codes i stedet for feltkoder. 

10.2 Hvor kan du finde mere information? 

Links Bemærkninger 

https://www.thedoctools.com/wordtips/dato-aendres-naar-word-

dokument-aabnes/ 

Artiklen Problemløsning – datoen ændres, når jeg åbner et eksisterende Word-

dokument omhandler et almindeligt problem med datoer – brug den rigtige type felt. 

https://www.thedoctools.com/wordtips/category/felter/ Her kan du bladre igennem artikler på min blog, som er relateret til Felter. Alle emner 

er vist under Find Word Tips om specifikke emner i panelet til højre på bloggen. 

https://www.thedoctools.com/wordtips/sitemap/ Via menuen Sitemap finder du links til alle artikler på min blog opdelt efter Emne, her-

under Felter. Emnerne er listet i alfabetisk orden. 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://www.thedoctools.com/wordtips/dato-aendres-naar-word-dokument-aabnes/
https://www.thedoctools.com/wordtips/dato-aendres-naar-word-dokument-aabnes/
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https://www.thedoctools.com/wordtips/dato-aendres-naar-word-dokument-aabnes/
https://www.thedoctools.com/wordtips/category/felter/
https://www.thedoctools.com/wordtips/sitemap/


 
 
10 gode råd – Lav bedre dokumenter på kortere tid i Microsoft Word 

Copyright © 2013-2021– Lene Fredborg, DocTools ApS, www.thedoctools.com – Tilmeld dig nyhedsbrev 15 

 

Hvis du har brug for hjælp til udvikling af skabeloner eller værktøjer til Microsoft Word 

Jeg kan tilbyde min assistance, hvis du eller din virksomhed har brug for hjælp i forbindelse med Word. Jeg kan f.eks. hjælpe med: 

◼ Udvikling af skræddersyede og gennemarbejdede skabeloner og værktøjer til Word, som kan hjælpe med at spare masser af tid og få styr 

på kvaliteten i virksomhedens dokumenter. 

◼ Konsulenthjælp og rådgivning i forbindelse med Word, f.eks. i relation til opgradering fra en version af Word til en anden. 

◼ Klippekortsordning, som kan bruges af en eller flere medarbejdere i en virksomhed, når der er behov for hjælp til at løse diverse problemer 

med dokumenter og Microsoft Word. Et enkelt klip på 15 minutter kan tit spare mange timers arbejde. 

◼ Ud over skræddersyede løsninger tilbyder jeg via min website wordaddins.com forskellige Word add-ins (tilføjelsesprogrammer) lige klar til 

brug. Hver add-in indeholder værktøjer til løsning af specifikke opgaver i Word. Formålet med hver add-in er at forenkle eller automatisere 

opgaver. Det er tit muligt at reducere mange timers arbejde til få minutter, endda i nogle tilfælde til mindre end et minut. 

Du er altid velkommen til at kontakte mig for at diskutere mulighederne. Jeg vil også meget gerne høre fra dig, hvis du har forslag til emner, du 

gerne vil have taget op på bloggen, i en e-bog eller andet. 

◼ Send en e-mail til info@thedoctools.com eller ring på 25 21 73 74. 

DocTools websites 

https://www.thedoctools.com 

https://wordaddins.com – Word Add-Ins - her finder du tilføjelsesprogrammer (add-ins) til Word, som kan hjælpe med at spare tid i Word 

Lene Fredborgs Word Blog – her finder du danske artikler om brugen af Microsoft Word 

https://www.thedoctools.com/wordtips 

https://www.thedoctools.com/
https://www.thedoctools.com/wordtips/ebog/nyhedsbrev/
https://wordaddins.com/
mailto:info@thedoctools.com
https://www.thedoctools.com/
https://wordaddins.com/
https://www.thedoctools.com/wordtips
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